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1 OVERVIEW 

This document provides detailed information about new features and functions included in the ETI 
Solution® 5.2 release. This document is intended to be used in conjunction with the ETI Solution Feature 
Matrix, which provides a summary of features for all major releases. This document includes information 
on features provided in the ETI Solution 5.2.0, 5.2.1, and 5.2.2 releases. Features provided as part of the 
5.2.1 and 5.2.2 releases will be marked as such. 

2 PLATFORM SUPPORT 

2.1 Supported Platforms 
The Solaris 2.9, AIX 5.2, and Windows 2003 Server operating systems are supported with the ETI 
Solution 5.1.1, 5.2.0, and later releases. AIX 5.3 operating system is supported with ETI Solution 5.2.1 
and later. For a complete list of supported platforms for ETI Solution 5.2, please refer to your ETI 
Solution Administration Guide, Appendix C. 

3 PRODUCT INTER-OPERABILITY 

3.1 Using Multiple ETI Solution Releases 
ETI Solution 5.2 can be installed and used on the same system as ETI Solution 5.0 and 5.1. ETI Solution 
5.2 is also compatible with ETI•EXTRACT® 4.2.  

3.1.1 Required Patches 

3.1.1.1 ETI Solution 5.1 & 5.2 

In order to migrate from ETI Solution 5.1.0 to 5.2 you must install ETI Solution 5.1.0 patch 02 or later. 
No patches are required to migrate between 5.1.1 and 5.2.0.  

3.1.1.2 ETI Solution 5.0 & 5.2 

In order to run both ETI Solution 5.0.3 and 5.2.0 on the same Windows server or standalone system you 
must install 5.0.3 patch 02. Contact the AnswerLine if you need patches for Windows systems running 
releases 5.0.0, 5.0.1, or 5.0.2. 

3.1.1.3 ETI•EXTRACT 4.2 & 5.2 

ETI•EXTRACT 4.2.2 and prior releases are obsolete. It is possible to run both ETI Solution and 
ETI•EXTRACT on the same system to facilitate migration to the new release. However, you must 
modify your ETI•EXTRACT 4.2 environment in order to run both releases. Review the ETI Solution 
Release Notes for information. 
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3.2 DSL Supported Features 
ETI Solution 5.1 or later is required for use with the following DSLs to ensure that all the DSL 
capabilities are supported: 

• DSL for C/FS DA 4.3.0 

• DSL for SQL/Teradata DA 4.2.1  

ETI Solution 5.2 or later is highly recommended for use with the following DSLs: 

• DSL for C/XML DA 4.3.0 

4 ADMINISTRATION CLIENT 

4.1 Application Overview 
The ETI Solution 5.2 Administration Client supports the V5 thin client architecture. The client can be 
used for remote administration, including dial-up and WAN client systems. The V5 Administration 
Client supports the administration of multiple MetaStore Servers from a single client system.  

The Administration Client no longer requires that a user be logged in as exadmin or a member of the 
exadmins group in order to access or run administration functions. Any person with the Administration 
Client installed on his/her system, and who has permission to run the application, can run most 
administration operations. Some operations are destructive; therefore access to the Administration Client 
should be controlled by operating system permissions or by limited installation. The Administration 
Client is not intended for use by Integration Specialists.  

Most administration functions are controlled by the ETI Process Server. The ETI Process Server must be 
set up to run as an actual user ID, rather than the default system account, in order to be used for 
administration operations. By default, ETI recommends using the exadmin user account for the ETI 
Administrator, but any user ID can be designated as the ETI Administrator.   

The owner of the MetaStore™ is controlled by the Log On identity of the ETI Process Server. Some 
operations such as backup and restore are restricted to the owner of the MetaStore. Therefore, care 
should be taken to ensure that the Process Server is set up with the ETI Administrator’s login ID and that 
multiple Process Servers are all configured to use the same ETI Administrator’s login ID. This facilitates 
shared administration from multiple Administration Clients. 

4.2 MetaStore Operations 
The Administration Client provides the standard MetaStore operations such as creating and deleting 
MetaStores, adding storage space, and checking storage space. The default MetaStore size and additional 
storage volumes are increased to 4 Gigabytes. 
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4.3 Loading DSLs and Consultant Packages 
• A consolidated documentation directory is used for ETI Solution documentation and DSL 

documentation. This is stored in the MetaStore Installation Area in the doc directory. 

• Improved DSL load interface 

o Simplified display – only shows products and not components 

o Select multiple products for loading 

• Simplified interface for updating MetaStores 

o Shows loaded products and Consultant Packages 

o Ability to identify unapplied DSL updates such as patches, upgrade kits, and Interim 
Maintenance (IM) Packages on a per MetaStore basis 

o Select multiple products for update 

4.4 Backup and Restore 
• Improved backup and restore interface  

• Default backup filenames are generated by the Administration Client to include the MetaStore 
name, release number, backup format (that is, full, objects only, or files only backup), date, and 
timestamp to facilitate identification during the restore process and to facilitate archival of 
multiple backup files. 

• Backup/Restore single or multi-volume MetaStores to same or new name 

• Create Backup Script command creates a backup script to facilitate scheduling unattended 
backups with a system scheduler. 

4.5 MetaStore Migration 
• Interface provided in the Administration Client 

• Eliminates need to run from command line on the server 

• Automated copying of the source MetaStore files for most platforms 

• Windows to UNIX migration requires a manual transfer of files between the source and target 
MetaStores. 

• New import option Resync conversions provided to migrate legacy conversions without 
resychronizing the Conversion and Schema 

4.6 Initial and Advanced Setup [Release 5.2.2] 

4.6.1 Architect Workset 

The Administration Client will automatically create an Architect workset in the new MetaStore as a child 
of the System workset. By default, the Administration Client will use the Architect workset for the 
creation and modification of objects such as the Host, User, and Installation. The Integration Architect 
can select an alternative workset in which to make modifications as appropriate. 
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4.6.2  Automatic Object Checkout 

The Administration Client will automatically check out objects when modifications are required. No 
objects are automatically checked in to System. This allows the Integration Architect to verify changes 
before impacting any project development activities.  

4.6.3 Set Up Projects 

The Projects command allows the MetaStore Administrator to create the initial project worksets in a 
new MetaStore or to add project worksets to an existing MetaStore.  

4.6.4 Create Users & Specify Access Control Settings 

The Users command assists you with the initial setup of user worksets, user objects, assignment of role-
based licenses, and the specification of access control settings by allowing you to:  

• Create users and specify their role (architect, specialist, analyst) 

• Assign a default set of access permissions for worksets and objects based on the user’s role 

• Specify the project(s) of which each user is a  member and create the associated user workset(s)  

• Adjust workset and object access permissions for individual users 

4.6.4.1 V4 Access Control Settings 

The Integration Client does not honor the V4 access control settings. The V5 Administration Client does 
not support the setup or modification of V4 object level access control. In order to set up or modify 
object level access for use with the V4 Browser, you must use the V4 Administration Tool (ex_gadmin). 
Refer to the original product documentation provided with your ETI•EXTRACT release for information 
on V4 access control. 

4.6.5 Set Up Hosts and Installations 

The Hosts command allows you to: 

• Create host objects for the MetaStore Server, source systems, and target systems 

• Create a default Installation object for each DAS used by a host system. 

4.6.6 Set Up the Executive 

The Executive command assists you to: 

• Set up the ExecHost to be the MetaStore Server 

• Specify an IP address to be used for establishing connections to a host system instead of the host 
name 

• Limit host connections (rarely needed) 

Host connections are no longer required in order to generate a conversion and execution plan file. If 
no host connections are specified, the Generation Engine will assume bi-directional connectivity to 
all hosts used in the conversion. For those rare cases where a site needs to limit host connections, the 
Executive command allows you to specify connection limitations. 
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4.6.7 MetaStore Access 

The MetaStore Access command permits you to: 

• Enable or disable private MetaStore access 

• Specify users that can open a private MetaStore 

4.7 Diagnostics and Resolving Problems 

4.7.1 Diagnostics 

• Updated diagnostics are provided for use with the V5 environment 

4.7.2 Session Monitor 

• Monitor client sessions for a specific user or all users 

• Cleanup of User Sessions 

o ETI Administrator can clean aborted sessions for any user. With prior releases you could 
only clean aborted sessions for the account currently logged in. 

o Clean aborted sessions and optionally save changes during cleanup. With prior releases you 
could clean aborted sessions, but were not able to save changes. 

4.7.3 Process Monitor 

• Ability to view/monitor all processes running on the Process Server 

• Kill any user process from the remote Administration Client  

4.8 Advanced Operations 
The following advanced operations are provided by the Administration Client: 

• Register additional MetaStore Servers 

• Reread the license file for Application Server 

• Restart the Application Server 

• Stop the MetaStore 

• Register additional Process Servers [Release 5.2.1] 

The Application Server’s configuration file is updated automatically to reflect changes in 
additional Process Servers.  

4.9 Differences and Limitations 

4.9.1 Compatibility between V4 and V5 Administration Clients 

The V4 Administration Tool (ex_gadmin) is not compatible with the V5 Administration Client for some 
operations. Specifically, if you use the V4 Administration Tool to create MetaStores with multiple 
volumes or use alternative storage locations, then you cannot use the V5 Administration Client for 
backup, restore, and adding additional storage space. For this reason, ETI recommends that the V4 
Administration Tool (ex_gadmin) only be used for the setup of V4 Access Control. For additional 
information regarding Access Control setup, refer to section 4.6.4.1. 
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The V4 Administration Tool has been removed from the ETI Start menu to avoid inadvertent usage. You 
can run the V4 Administration Tool manually from the ETI Command Window. See the ETI Solution 
Release Notes for additional information.  

Customers running in host-centric mode, with UNIX MetaStore Servers, must use the V4 Administration 
Tool. The V5 Administration Client does not run on a UNIX system.  

4.9.2 DSL Load 

• When using the Administration Client to load ALE (part of the DSL for SAP/R3), you must use a 
UNIX Process Server to load into a UNIX MetaStore Server.  

• The V5 Administration Client does not support re-loading DSLs into an existing MetaStore. If 
you need to reload a DSL, you can use the V4 Administration Tool. 

4.9.3 License Management 

• Provided via LMTOOLS graphical interface on Windows 

• Provided via command line interface on UNIX 

4.9.4 Manual Processes 

• Reorganize MetaStore – manual process 

4.9.5 Obsolete and/or Dropped Functionality 

• Show worksets functionality – removed 

• The V4 Administration Tool will be obsolete with ETI Solution 5.3. 

5 INTEGRATION CLIENT 

5.1 Browser 

5.1.1 Open MetaStore 

• The Integration Client will warn when the MetaStore storage volumes are close to their capacity. 

5.1.2 Checkin, Checkout, and Uncheckout 

• Checkin Model  

o Improved checkin model for template libraries and conversions. 

The checkin of a conversion will automatically checkin the new/modified schemas, 
databases, and code blocks referenced by the conversion. This change ensures that the parent 
workset contains the complete “generation set” of objects. This change avoids having 
schemas and conversions out of sync in the parent workset. 

o Checkin of template libraries will automatically checkin the modified/new template modules 
referenced by the template library.  

With prior releases only new (not modified) template modules were automatically checked in 
with the template library. This change ensures a complete “generation set” for the template 
library. 
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• The Browser now allows the checkin, checkout, and uncheckout of all objects in a category. 

• The Browser allows multiple objects to be selected for checkin, checkout, and uncheckout. 

5.1.3 Access Control 

Per user access to the MetaStore is now supported for both the Integration Client and the Integration 
Architect Client interfaces. [Release 5.2.2] 

Per user access to worksets and object categories is enforced with private MetaStores. [Release 5.2.2] 

The Show Info dialog can be used to view current Access Control settings for a user, workset, or object 
category. Users who have permission to modify Access Control can view access control settings for all 
users. [Release 5.2.2] 

5.1.4 Import and Export 

• The Resync conversions option is provided to import legacy conversions without re-
synchronizing the conversion and schema. 

• Imports are serial. [Release 5.2.1] 

When you select more than one object to import, the imports run in sequential order.  If an 
import is currently running and you select additional objects to import, the additional objects are 
added to the same import queue.  All output information is routed to the same output tab.  The 
output tab has a status line that indicates where the import is in the process. 

• When an object is exported or migrated from a 5.2.2 MetaStore, the original creation date, 
creator (user name) and checkin history information is exported. [Release 5.2.2] 

This allows the information to be preserved during import/migration to a different MetaStore 
running ETI Solution 5.2.2 or later. 

5.1.5 Properties Dialog 

You can view and modify object level properties from the Browser. This provides a quick way of 
changing properties on objects such as the installation or conversion without incurring the expense of 
opening the object into the work area or an editor.  

5.1.6 Attachments Dialog 

Occasionally the Integration Architect must attach templates and grammars to objects such as 
installations and global data. Attaching templates and grammars is usually done during the initial 
MetaStore environment setup. In the old interface this capability was provided as part of the environment 
object editor.  

The 5.2 interface provides a simplified method for viewing, attaching, and detaching templates and 
grammars via the Attachments dialog. If you select a database, installation, global data, or DAS object in 
the Browser, the Attachments… menu item will be active on the right click menu. 

The Attachments dialog will display available templates as well as the currently attached templates. If the 
object supports the attachment of grammars, then a second tab will be available in the dialog to manage 
grammar attachments. 

It is no longer necessary to copy all of the templates or grammars into the current workset in order to 
attach them to an object. The Attachments dialog will automatically display all legal attachments in the 
workset hierarchy (current workset up to the System workset).  
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5.1.7 Show Info 

The Show Info command will now display the creation date, user, and history for objects migrated or 
imported from 5.2.2 MetaStores. [Release 5.2.2] 

5.1.8 Browser Object Display 

The Browser now supports the display of objects sorted by modification date. This feature can be 
enabled/disabled using the Browser/General preference Sort objects by last modified date. [Release 
5.2.2] 

A new Browser preference Show last modified date allows you to display object modification dates in 
the Browser Area. [Release 5.2.2] 

5.1.9 Reset Save Version 

The Reset Save Version command has been added to the Integration Client, allowing you to choose a 
save version of an object to which you can reset temporarily for read-only viewing, or permanently for 
editing. [Release 5.2.2] 

5.1.10 Browser Save As 

The Save As command is provided in the Browser allowing you to make a copy of an object without 
opening the object into a Work Area. [Release 5.2.2] 

5.1.11 Limitations 

The Browser Area for the Integration Client provides most operations used by both the Integration 
Architect and Integration Specialist. The following operations are limited to the Integration Architect 
Client V4 Browser interface: 

• Running registered tools  

• Patch Overrides/Overrides Patch 

5.2 Conversion Compiler 

5.2.1 Performance 

In general, the generation times have been reduced by 25-50% between the 5.0 and 5.2 releases, with 
larger conversions having the greatest reduction in generation times.  

In general, the generation times have been reduced by 10-15% between the 5.1 and 5.2 releases. 

5.2.2 Copy and Paste Keyboard Shortcuts for the Debugger 

The Conversion Compiler debugger now allows you to use the keyboard shortcuts Ctrl-C and Ctrl-V to 
copy and paste information to the debugger window. [Release 5.2.2] 
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5.3 Conversion Work Area  

5.3.1 Nested Subunit Display 

The 5.2 release provides the ability to display the conversion, mapping specification, and schema 
information using nested subunits rather than a flat display that uses pointer parts to represent the unit 
hierarchy.  This capability is provided in the Schema Work Area and in both the Graph and Table Areas 
of the Conversion Work Area.  

The Preferences dialog is used to control whether the pointer part or nested subunit display style will be 
used by the work areas. In order to switch between the two display styles, you must close and reopen the 
conversion or schema object.  

5.3.2 Goto Mapped Part 

When working with a large schema, it can be difficult to locate a mapped part. The Goto Source Part 
and Goto Target Part commands will automatically scroll the source or target Table Area to the mapped 
part.  To invoke the command, just select the mapping for a part (expand the part if needed to display the 
mappings) and then select View->Goto Source/Target Part.  The actual menu item name changes based 
on which mapping you select; for example when you select a mapping on the source side, the menu item 
will read Goto Target Part.  If you have not previously expanded the display to show the mapped part, 
this command can take time to display, as the associated source or target part must be loaded first.   

5.3.3 Displaying Mappings in Detail Area 

When you select a source or target mapping, the part represented by the mapping is now displayed in the 
Detail Area. If you have not previously expanded the display to show the mapped part, the selected 
mapping can take time to display, as the associated source or target part must be loaded first. There is a 
preference which turns off the display of the mappings in the Detail Area.   

5.3.4 Find Dialog – Incremental Search [Release 5.2.1] 

A Find command has been added to the Edit menu and right click menu (shortcut key is Ctrl-F). This 
will let you search by name for units and parts. 

5.3.5 Refresh Command [Release 5.2.1] 

A Refresh command is provided. It provides two levels of refresh. A Quick refresh will reload 
grammars, GEMs, and issues. Refresh Full will reload all objects, including databases and schemas. The 
conversion will be resynchronized as necessary.  If you perform a Full refresh, then the graph and table 
are collapsed. 

5.3.6 Dynamically Resizable Graph Columns 

The columns in the Graph Area can be dynamically resized by dragging the column dividers in the Graph 
heading area. 

5.3.7 Issues [Release 5.2.2] 

For details, refer to section 5.4.2.  
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5.3.8 Clear All [Release 5.2.2] 

The Clear All command was added to display a dialog where you can choose the items to clear 
from the selected conversion, including mappings, business rules, business rule warnings, default 
values, conversion properties, or all of these items.  

5.3.9 Compare Command [Release 5.2.2] 

The Compare command is now supported to compare changes that were made between various save 
versions of a conversion. To compare changes for the save versions of the current conversion, select 
Conversion->Compare. 

Note This command is also available for mapping specifications by selecting  
Mapping Specification->Compare. 

5.3.10 Limitations and Differences  

5.3.10.1 Additional Source Units 

With the 5.1 release, additional source units are no longer identified using the property 
additional_source_units on the target unit. The information is now specified via the Integration Client 
interface and is stored internally as a data structure. During the migration process or import/export 
process, any properties will automatically be converted to the internal data structure format. You can no 
longer specify additional source units via the older Integration Architect interface with releases 5.1 or 
later. If you set the property manually, it will be ignored by the Conversion Compiler.  

5.3.10.2 Sequence Numbers 

Sequence numbers are not applied to navigational joins (joins that represent parent-child relationships). 
If you set a sequence number on this type of join, it will be ignored by the Conversion Compiler. 

If the same join is applied to the merge logic for two different target units, then only a single sequence 
number can be set. You must ensure that the sequence number is set appropriately for the processing of 
both targets. Alternatively, you can use virtual units to achieve greater control over join processing. 

5.4 Mapping Specification Work Area [Release 5.2.2] 
The new Mapping Specification object category has been added with this release. The Integration 
Analyst specifies data mappings and the associated business logic for the Mapping Specification using 
the new Mapping Specification Work Area. This provides an easy to use interface that allows the 
Integration Analyst to create the mapping specification document allowing the information to 
automatically transfer to the conversion specification. The Mapping Specification is a licensed feature 
that is only available if the Integration Analyst license is available. 

5.4.1 Integration Analyst User 

This new licensed role defines the new type of user who creates the mapping specification document 
using the Mapping Specification Work Area. 
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5.4.2 Issues 

ETI is introducing support for issues to allow them to be tracked during the development cycle for 
mapping specifications and conversions. Issues are things to note or questions to ask about a particular 
item (databases, units, and parts only). 

Issues can be created and modified in mapping specifications and in conversions. Issues will be shared 
among the mapping specification and the conversions that are derived from it across all versions of those 
objects. Each issue can have multiple responses/updates. 

For each issue you can specify the following: 

• Summary — provides a short text description of the issue 

• Description — provides a detailed text description of the issue 

• Comments — provides a location where responders can enter a detailed text description of their 
response to the issue 

• Priority — indicates the priority of the issue as one of the following: Low, Medium, High, or 
Critical 

• State — a pull-down menu where you can set the status of an issue to one of the following 
values:  Open, Responded, Closed  

• Assigned to — indicates the user to whom the issue is assigned 

• Send email — automatically displays your email program when you select Apply or OK to allow 
you to send email regarding the issue 

An issue number is automatically assigned by ETI Solution. 

5.4.3 Business Logic 

Business logic allows you to provide a detailed specification of the logic and processing required for a 
conversion. The business logic is used by the Integration Specialist to design and implement the 
conversion. The business logic is specified as multi-line free form ASCII text. You can copy and paste 
text from other applications and documents to be included as part of the business logic specification. The 
business logic grammars can be customized to meet site-specific or project-specific requirements. 

5.5 Code Block Work Area 
• The Find command now provides the ability to find and replace text. [Release 5.2.2] 

• The Insert Slot, Insert Char Slots, and Insert Date/User commands in the Code Block menu 
have been added. [Release 5.2.2] 

• The Bookmarking and Outlining commands in the View menu have been added. [Release 5.2.2] 

• The Show White Space and Show Line Numbers commands in the View menu have been 
added. [Release 5.2.2] 

• The Code Block Work Area has been updated to be consistent with the new Grammar Extension 
Module Work Area. [Release 5.2.2] 



ETI Solution Feature Summary 5.2e 

Page 16  

• If a migrated code block contains an invalid function header (i.e. a missing # character at the 
beginning of a line or a missing header line), the code block will be loaded into the editor. The 
code block function and incorrect header information will be displayed in the editor. The user 
must manually correct the code block header and save the changes before the code bock can be 
used by a conversion. [Release 5.2.2] 

• Copying text from a Word document and pasting it into the Code Block Work Area is now 
supported. [Release 5.2.1] 

• Renaming a code block function now allows use of the underscore character.[Release 5.2.0] 

5.6 GEM Work Area [Release 5.2.2] 
The Integration Client now provides a thin client interface for GEMs. 

5.7 PGEM Work Area [Release 5.2.2] 
The Integration Client now provides a thin client interface for PGEMs. 

5.8 Executive 

5.8.1 The DSL Component for the Executive 4.3.0 

• Packaged separately from the DSL for Shared Objects to facilitate patching and updates without 
impacting loaded MetaStore objects. 

• Eliminates unnecessary password prompting for DAS objects. 

• The Executive client code provides better WAN client performance. Processing of the map and 
plan file provides faster startup and password processing. Performance improved by up to 90% in 
some cases.  [Release 5.2.1] 

5.9 Retrieve Schema 

5.9.1 Input Parameters Saved 

When you retrieve a schema, the input parameters you use (for example database information file) are 
saved as part of the schema object that is created.  If you then re-retrieve the schema, the input 
parameters will default to the values you used on the previous retrieval.  The saved parameters are not 
displayed by the Schema Work Area and can only be modified by the Retrieve Schema dialog. 

5.9.2 Limitations 

5.9.2.1 DSL for SAP R/3 and Starter Kit for COBOL/IDMS 

The retrieve schema process for the DSL for SAP R/3 and the Starter Kit for COBOL/IDMS can only be 
run from the Integration Architect Client by using the V4 Browser and retrieve schema interfaces. This 
will be addressed in a future release. 
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5.9.2.2 DSL for COBOL/FS DA Limitations 

It is recommended that you use the Integration Client for retrieving schemas and setting date formats. If 
you switch between the V4 Schema Editor and the Integration Client Schema Work Area then you may 
experience a loss of date formats or inconsistent results. ETI recommends that you select one client 
interface and use it consistently.  

5.10 Schema Work Area 

5.10.1 Nested Subunit Display 

See the description in section 5.3.1. 

5.10.2 Subunit Enclosures and Delimiters 

• Added subunit enclosures and delimiters for cfs_da and cxml_da schemas. 

5.10.3 Specifying Numeric Formats  

• Improved numeric format setting for cfs_da and cxml_da schemas: 

o Validation checks made on data entered 

o Added support for signed decimal and integer formats  

5.10.4 Find Dialog – Incremental Search [Release 5.2.1] 

A Find command has been added to the Edit menu and right click menu (shortcut key is Ctrl-F).  This 
will let you search by name for units and parts. 

5.10.5 Create Virtual Subunits [Release 5.2.1] 

Ability to create virtual units for subunits (i.e. non-record units). 

5.11 Template Work Area 
A new Work Area for modifying templates, template libraries, and template modules has been added.  
Any combination of template objects (and multiples of each) can be edited in a single session.  This gives 
the user a great deal of flexibility in making changes and searching templates.  With a few minor 
exceptions, the new Template Work Area has all of the functionality of the V4 Template Editor, but does 
so using the V5 ETI Solution interface.  Key new features are detailed below. 

5.11.1 Template Browser Area 

5.11.1.1 Opening Objects for Modification and Viewing 

• You can open and edit one or more template libraries without opening their associated template 

• You can open one or more template modules without opening their associated Library 

• You can drag and drop objects from main browser to add to session 

5.11.1.2 Improved Display 

• Displays indicators for syntax errors/warnings 

• Displays read/write/modification icons 
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5.11.1.3 Search and Find 

• Can do searches across all open objects or constrain the search to a module, library, or template 

5.11.1.4 Simplified Checkout and Modification Paradigm 

• Automatic checkout of objects when you attempt to make your first change 

• Automatic checkout is only one level in the 5.2 release (that is, object will still have to be 
checked out in the parent workset). Release 5.2.1 supports checkout from any location in the 
hierarchy. 

5.11.1.5 Performance Enhancements 

• Load on demand, for example no function text transferred to the client until you traverse to that 
function or explicitly open it 

5.11.1.6 Visual Function Compare 

• Compare two functions using a visual “diff” 

• Color-coded, side-by-side comparison with synchronized scrolling and bookmarks set at each 
difference for quick and easy navigation 

5.11.1.7 Results Area  

• Displays the results of search operations, syntax checking, and function overrides as a template 
function list 

• Provides quick navigation from the results to the associated template function 

5.11.1.8 Overrides and Overridden 

• List function overrides in Results Area 

• Single click to compare overrides from Results Area 

5.11.2 Template Function Editor Area 

• Each template function opened is displayed in an edit tab inside the function editor. The edit tabs 
replace the buffer concept used by the V4 Template Editor. 

• You can split the edit tab view to display multiple functions side by side or top and bottom. 

• You can also split a single tab to see two parts of the same function. 

5.11.2.1 Auto-recover Option for Template Functions 

• The Template Work Area records changes to template functions which have not been saved to 
the MetaStore. These recorded changes will be automatically recovered during client startup in 
the unlikely event that the client application crashes or loses its connection to the Application 
Server.  

• Changes to template functions are automatically recorded every time you switch edit tabs or 
move focus from the edit tabs to the Template Browser Area. 

• The changes to template functions become permanently saved to the MetaStore when you save 
the function’s template module or during the automatic recovery. 

• The user has the ability to revert functions that have been changed before saving the template 
module or before closing the Template Work Area. 
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• The auto-recovery option is enabled by default.  It can be disabled by changing a preference.  If 
this option is disabled, no changes are recorded and any unsaved changes to template functions 
are lost in the event of a client crash or loss of connection. 

5.11.2.2 Auto-insert of Slot Syntax and Popup Help for Slot Syntax 

• Auto-insert slot syntax 

The user can type the name of a slot, press the spacebar, and the editor will automatically insert 
the most common slot syntax into the template function. The user can then modify the slot to 
provide the information required.  The syntax inserted is the same slot syntax inserted by the 
Insert Slot command. A preference controls this feature which is disabled by default. 

• Popup help for slot syntax 

With this feature, the user can type the name of a slot, press the spacebar, and a popup is 
displayed listing all the syntax options for the slot, along with some documentation of the 
parameters. Some slots have several different options. In this case, the user will be able to scroll 
through the various slot options to select the desired slot syntax.   

o Helpful to the beginner — Provides examples of each calling syntax and 
documentation  

o Helpful to the expert for remembering the syntax for rarely used slots 

o A preference controls this feature which is disabled by default.   

o Also available as a manual feature by pressing the F1 key after you have entered the 
name of a slot. 

• Customizable Syntax Files 

The slot syntax and slot help files are shipped with the product and can be customized or 
modified by the user. This allows you to add information or delete slots that are not used at your 
site. 

5.11.2.3 Extended Search 

• Users can search an individual function, module, library, or template. 

• Users can search all open objects. 

• When searching across multiple functions and display results, the functions will have lines 
marked with bookmarks where matched text was found. 

• Users can search for text or search explicitly for function definitions and function overrides. 

5.11.2.4 Bookmarks 

• A way to set markers in template functions that you want to quickly move between.  They remain 
active until you turn them off or until you close the edit tab for the function. 

• You can set bookmarks manually. 

• Auto-generated as part of the Find in Context, Compare Functions and Check Syntax 
operations. 

5.11.2.5 Outlining 

• Can mark a block of text and collapse it to a single line to facilitate viewing and modifying large 
functions. 

• Outlining stays until you turn it off or close the edit tab. 
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5.11.2.6 Facilitating Template Function Development  

• A new command Insert Char Slots will replace all of the reserved characters with their slot 
equivalents in the text of a template function. [Release 5.2.1] 

• A new command Insert Date/User will insert the current date and user ID into the text of the 
current template function. 

5.12 Preferences 

5.12.1 Browser 

• Browser preferences, specifically those for Version number and Newer object exists indicator, 
take effect immediately (without restarting the Integration Client). [Release 5.2.2] 

• A new Browser preference Show last modified date allows you to display object modification 
dates in the Browser Area. [Release 5.2.2] 

• A new Browser preference Sort objects by last modified date allows you to sort and display 
objects by modification dates in the Browser Area. [Release 5.2.2] 

5.12.2 Conversion  

• A preference allows you to control whether a flat hierarchical display (pointer parts) or the 
nested subunit display is used by the Conversion Work Area. Nested subunit display is the 
default setting.  

• A preference was added to control the default size of the source and target graph columns for the 
Conversion Work Area. This allows the user to adjust the size to accommodate long unit and part 
names. 

• A preference was added to display selected mapping in the detail area.  If you have not 
previously expanded the display to show the mapped part, the selected mapping can take time to 
display, as the associated source or target part must be loaded first.  Default is “on.” 

• A new Conversion/Business Rule Dialog preference Auto replay has been added. This 
preference is enabled by default. When Auto replay is turned off, the Business Rules dialog will 
open and display the selected Business Rule without replaying. This option can improve 
performance when opening large rules. Additionally, it allows more options for debugging 
problems, since you can review the rule exactly as used for generation prior to replaying. 
[Release 5.2.2] 

5.12.3 Mapping Specification 

• A preference was added to control the default size of the source and target graph columns for the 
Mapping Specification Work Area. This allows the user to adjust the size to accommodate long 
unit and part names. 

5.12.4 Schema 

• A preference was added to control whether a flat hierarchical display (pointer parts) or the nested 
subunit display is used by the Schema Work Area. Nested subunit display is the default setting. 

• A new preference Default to Merge Schema option for re-retrieval has been added. This 
option allows you to have the Merge Schema option selected as the default when re-retrieving 
schemas. [Release 5.2.2] 
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5.12.5 Template [Release 5.2.1] 

• All template preferences are new for this release.  See the online help for a description of the 
template preferences. 

6 ETI IMPACT ANALYST 

6.1 Impact Analyst Executive  
With prior releases, ETI provided Executive scripts for transferring unload files and uploading the ETI 
Meta Data Warehouse. These Executive scripts are now incorporated into the DSL for Shared Objects 
release 4.3 and are provided for backward compatibility.  

The use of the Executive with Impact Analyst is provided for backward compatibility but will be obsolete 
with the 5.3 release.  

6.2 Scheduled Updates  
ETI recommends setting up an RDBMS client on the MetaStore Server and using trusted connections for 
uploading information to the ETI Meta Data Warehouse.  

The ETI Solution Administration Client generates a script which can be used with a production scheduler 
and an RDBMS client to schedule updates to the ETI Impact Analyst Meta Data Warehouse.  

6.3 Oracle 9i Support 
ETI Impact Analyst supports the use of an Oracle 9i Meta Data Warehouse. 

7 ETI SOLUTION SERVERS 

7.1 Application Server 
• Multi-threaded operations 

o All Application Server operations are now multi-threaded 

o Improved performance for concurrent operations 

o Improved performance of the Business Rules dialog 

o Changes to improve concurrent access during long operations such as object checkin, 
uncheckout, open, save and close operations 

o TCL has been upgraded to release 8.4.3 for improved multi-threaded operations. 
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7.2 MetaStore Server 
• Versant has been upgraded to the 6.0.5 release in support of new operating systems. 

• TCL has been upgraded to release 8.4.3 for improved multi-threaded operations. 

• Object locking model 

A finer-grained locking scheme for long transactions has been used to minimize blocking and 
improve concurrent access. Improved operations include object checkin, uncheckout, open, save, 
and close operations. 

7.3 Process Server 
• Process Server for UNIX  

o Supports the same operating systems as the UNIX MetaStore Server. 

o Supports the same operations as the Windows Process Server. Specifically retrieve schema, 
import, export, package conversion, administration, and the Conversion Compiler. 

• The 5.2 Process Server is backward compatible with ETI Solution 5.0 and 5.1 (Windows) 

• The 5.2 Process Server must be used when running multiple ETI Solution releases on the same 
system. 

8 ETI SOLUTION DOCUMENTATION 

8.1 Online Documentation Location 
With release 5.2, all documentation will be consolidated into the doc directory in the MetaStore 
Installation directory (for example c:\eti\solution\doc). Additionally, the latest software for loading DSLs 
has been modified to install all PDF documentation for DSLs into the same location. PDF files will no 
longer be installed in each MetaStore. 

 
 


